
Tässä oppaassa esitellään Sibeliuksen keskeisen valikon, Create, 
toimintaa. Valikko avataan tavanomaisesti ikkunan yläreunasta, 
mutta se voidaan avata myös riippumatta siitä missä kohtaa hiiri on 
pitämällä ctrl-nappulaa alhaalla, kun hiiri painetaan pohjaan 
(Mac), tai hiiren kakkosnäppäimellä (Windows). Valikon 
komennoilla tuotetaan tahteja ja tahtimerkintöjä, graafisia 
merkkejä, tekstikenttiä, jne. Toimintoja esitellään samassa 
järjestyksessä, kuin ne esiintyvät itse valikossa.

Create-valikon komennot toteutetaan kahdella eri tavalla: 

1. Jos jokin tahti tai tahdinosa on aktivoitu, komento kohdistuu 
kyseiseen kohtaan. 

2. Jos aktivointia ei ole tai komento ei sitä tarvitse, muuttuu nuoli 
komennon jälkeen siniseksi, jolloin komennon toimenpide osoitetaan 
nuolen avulla haluttuun paikkaan – toimenpide tipautetaan paperille. 

Näppäinoikotiet. Esittelyn myötä tulee vaihtoehtoina 
näppäinoikoteiden käyttö. Tällainen ilmaistaan Macintoshissa cmd-
merkillä. Kun komento voidaan siis suorittaa pitämällä cmd ()-
näppäintä pohjassa sekä painamalla ao. kirjainta, on esitys 
esimerkiksi seuraavanlainen: cmd-B.

Windows-käyttöjärjestelmässä vastaava menettely tehdään ctrl-
näppäimen avulla (siis ctrl–B). Lyhyyden vuoksi vain Macintosh-
merkintä on käytössä. Pelkkä lihavoitu kirjain ilmaisee, että 
komennon voi tehdä painamalla yhtä kirjainta. Esimerkiksi Q-kirjain 
avaa nuottiavainikkunan.

Valikoissa tai valintaikkunoissa esiintyvä englanninkielinen teksti 
ilmaistaan kursivointina. Kun valikosta otetaan jokin komento tai 
mennään alavalikkoon, käytetään toimenpiteestä > -merkkiä. 
Create>Barline>Start Repeat tarkoittaa sitä, että ensin avataan Create-
valikko, valitaan sieltä Barline, jolloin avautuu apuvalikko. Sieltä 
valitaan Start Repeat. 

Create-valikon komentoja on mahdollista muokata. Tähän työkalut 
löytyvät House Style -valikosta. Kyseiset toiminnot käsitellään 
toisaalla.
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Bar-komennosta avautuu alavalikko, jossa on kolme vaihtoehtoa:

At End lisää tahteja kappaleen loppuun. Tämä on tehokkainta 
toteuttaa näppäinoikotienä cmd-B. Kokeile pitää näppäimiä pohjassa 
pitempään ja Sibelius juoksuttaa tyhjiä tahteja nuottisivulle 
vauhdikkaasti.

Single aktivoi nuolen ja voit tipauttaa tyhjän tahdin keskelle 
partituuria. Klikkaa tahtia, jonka eteen haluat tyhjän tahdin. Toinen 
vaihtoehto on aktivoida tahdinosa halutussa tahdissa ja sen jälkeen 
hakea valikon komento, jolloin uusi tahti ilmestyy.

Other-komennolla voit määrätä montako tahtia haluat nuolen kanssa 
tehdä. Siellä on vaihtoehtona tehdä myös tahtiosoituksesta 
poikkeavan mittaisia tahteja. Tällainen tarve tulee vastaa esimerkiksi 
silloin, kun on tehtävä vapaarytminen resitatiivi tai kohotahdin 
vuoksi vajaa tahti kappaleen loppuun. Kun Irregular on valittu, 
kerätään ponnahdusvalikosta aika-arvoja haluttu määrä. Esimerkissä 
ollaan luomassa kolmen kahdeksasosan mittaista tahtia.

Uusi tahti tipautetaan nuottisivulle nuolella samaan tapaan kuin 
edellä.

Poista tahti. Osoita haluttua tahtia, sen ympärille tulee sininen kehä. 
Poista tahti cmd-näppäin pohjassa Delete-näppäimellä, ja koko tahti 
häipyy. Tahdin sisältö sen sijaan poistetaan Delete-näppäimellä (ei 
cmd-näppäintä).

Sibelius tekee tavalliset tahtiviivat automaattisesti sekä laittaa 
kappaleen loppuun paksun kaksoisviivan.


 
  2

1. Bar



Barline-komennon takana on alavalikko, jonka avulla voidaan luoda 
erilaisia tahtiviivoja. Niistä on kooste seuraavassa kuvassa.

Valitse sopiva tahtiviiva ja pudota se nuolella haluttuun paikkaan. 
Tahtiviivan voi laittaa muuallekin kuin korvaamaan alkuperäistä, 
esimerkiksi keskelle tahtia. Tahtiviiva yhdistää eri stemmoja ja tätä 
yhdistelyä voi muuttaa seuraavasti: osoita joko tahtiviivan ylä- tai 
alapäätä ja sininen neliö ilmestyy. Raahaa neliötä ylös tai alas ja 
tahtiviiva muuttaa mittaa. (Ks. Seuraavat kuvat.)

Sointumerkit tehdään seuraavasti: 

• Create>Chord symbol (cmd–K) 

• osoita halutun nuotin yläpuolella 

• kirjoita sointumerkki (b tekee alennusmerkin ja # korotusmerkin) 

• välilyönnillä hypätään seuraavaan nuottiin.

Sointumerkin ensimmäinen kirjain voi olla pieni, Sibelius kääntää sen 
suuraakkoseksi. Samalla tavalla kirjoitettu adim kääntyy 
automaattisesti merkiksi  A°. Merkkien tulkintaa voi määritellä 
komennolla House Style>Engraving Rules>Chord Symbols.

Suomalaista käyttäjä saattaa kiinnostaa myös pohjoismaisen 
merkistön käyttö, minkä mukaan käytetään sointuja H ja alennettuna 
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2. Barline

3. Chord Symbol



Bb. Valinta onnistuu myös komennolla House Style>Engraving 
Rules>Chord Symbols.  Ikkunasta valitaan kieleksi Scandinavian. 

Soinnut voi kirjoittaa MIDI-koskettimiston avulla, jos sellainen on 
kytketty tietokoneeseen.. Kuten edellä, valitaan Create>Chord symbol, 
osoitetaan nuotin yläpuolelle ja soitetaan perusmuotoinen sointu 
koskettimistolta. Ja välilyönnillä hypätään seuraavaan nuottiin. Jos 
tarvitaan soinnun käännös, soitetaan perusmuotoinen sointu ja sen 
alle haluttu basson sävel.

Lähtökohtaisesti Sibelius kirjoittaa sointumerkit ilman kitaran 
sointuotteita, ellei kyseinen instrumentti ole kitara. Kitaraotteet saa 
näkyviin komennolla House Style>Engraving Rules>Chord Symbols. 
Ikkunasta poistetaan valinta Only show chord diagrams on guitar 
notation on staves.

Mikäli sointuote ei ole mieluinen, voidaan kierrättää eri vaihtoehtoja 
komennolla Edit>Chord Symbol>
Respell Chord Diagram. Sointuotetta 
voi myös itse räätälöidä. Edit>Chord Symbol>Edit Chord Diagram avaa 
ikkunan, jossa otetta voi muokata. Otteen nauhoja osoittamalla voi 
sointuotetta muuttaa, otemerkin yläpuolella voi määritellä kielen 
Shift-näppäimen avulla avoimeksi tai mykistetyksi. Lisäksi nauhaa 
pitkin nuolta raahaten voi tehdä barré-otteita. Sointuotteen 
sormituksen voi ohjeistaa kaksoisosoittamalla kyseistä kieltä.
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Nuottiavaimia tehdään samalla tavalla kuin tahtiviivojakin, 
Create>Clef -komennolla avautuu ikkuna, jossa on eri vaihtoehdot 
tarjolla. Näppäinoikotie on Q. Tipauta avain sopivaan paikkaan. 
Jälleen avain voidaan laittaa myös aktivoimalla tahdinosa ja sitten 
valitsemalla sopiva avain. Avain voidaan poistaa aktivoimalla se ja 
painamalla Delete.

Avainta voi siirtää hiirellä. Liikuttele avainta, samalla nuotit 
transponoituvat automaattisesti. Jos avain vaihtuu rivinvaihdon 
yhteydessä, edellisen viivaston loppuun tulee avain huomauttamaan 
vaihdoksesta. Tuon avaimen saa pois näkyvistä siten, että ensin 
valitset tarpeettoman avaimen, sitten komento Edit>Hide or 
Show>Hide tai cmd-Shift-H.

Valintaikkunan teksti 
Draw on subsequent staves 
kannattaa yleensä jättää 
voimaan. Jos 
valintaneliön tyhjentää, 
avain ei ilmesty 
seuraavien viivastojen 
alkuun.

Työvaiheen edetessä voi nuottisivulle laittaa muistilappuja 
Comment-komennolla. Create>Comment (alt-shift-C) sijoittaa keltaisen 
kirjoituskentän aktivoidun alueen päälle, tai ilman aktivointia sen voi 
tipauttaa sopivaan paikkaan. Kirjoita kommentti ja paina esc. 
Muistilapun kokoa voi muuttaa hiirellä lapun oikeasta alakulmasta.
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5. Comment

4. Clef



Nuottisivulle voi sijoittaa kuvia sillä edellytyksellä, että kuvat on 
tallennettu TIFF-formaattiin. Create>Graphic avaa valintaikkunan, 
jonka avulla haetaan haluttu kuva. Jos jokin tahdinosa on valmiiksi 
aktiivinen, kuva ilmestyy siihen kohtaan, muutoin kuva tipautetaan 
nuolen avulla paikalleen. Kuvaa voi siirrellä ja venytellä hiiren 
avulla. Kuvakoon muuttaminen suuremmaksi heikentää kuvan 
laatua, joten ainoastaan muokkaus pienempään suuntaan on 
käyttökelpoinen. Mikäli on syytä palauttaa muokkauksen jälkeen 
kuva ennalleen, valitaan Layout>Reset Design. Kuva poistetaan 
aktivoimalla se ja painamalla Delete-näppäintä. 

Jos samaa kuvaa käytetään useasti samassa dokumentissa, on syytä 
kopioida ja sijoittaa se mieluummin kuin tuoda se dokumenttiin 
uudelleen. Tällä tavoin dokumentin koko ei tarpeettomasti kasva.

Mikäli haluat käyttää jotain kuvaa, joka ei ole TIFF-formaatissa, avaa 
se kuvankäsittelyohjelmassa ja tallenna se sitten TIFFiksi.

Viivaston jokin osa voidaan korostaa keltaisella värillä. Aktivoi 
haluttu lue ja valitse Create>Highlight. Korostettua aluetta voidaan 
siirtää hiirellä raahaten. Sitä voidaan venyttää tarttumalla alueen 
reunaan ja se voidaan poistaa osoittamalla alueen reunaan ja 
painamalla Delete-näppäintä. Korostetut alueet voidaan kätkeä 
komennolla View>Highlights. Normaalisti korostuskenttä ei tulostu. 
Tulosta-ikkunassa voidaan valita tulostusta varten View menu options, 
jolloin ko. valikon kaikki näytetyt merkinnät tulostuvat.

Partituuriin voidaan lisätä tai siitä voidaan poistaa instrumentteja. 
Lisäksi niiden partituurijärjestystä voidaan muuttaa milloin vain. 
Tämä tapahtuu Instruments-komennolla (I). Näkyviin tulee tuttu 
ikkuna, josta valitaan sopiva soitinvalikoima (Choose from:) ja 
soitinperhe (Family:). Soitinvalikoimaksi valitaan yleensä Common 
Instruments, näin vältetään eksymästä Sibeliuksen tuntemaan 
soitinviidakkoon. Soitinperheestä valitaan haluttu soitin ja se lisätään 
Add to Score -painikkeella partituuriin. Soitin poistetaan siten, että se 
aktivoidaan ja painetaan Delete from Score-painiketta.

Partituurijärjestystä vaihdetaan siten, että ensin aktivoidaan soitin ja 
sitten Move Up ja Down -painikkeilla vaihdetaan paikkaa.
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7. Highlight

8. Instruments

6. Graphic



Staves in score -kentän alla on Small staff -valintaneliö, jonka avulla 
jokin viivasto voidaan muuttaa pienemmäksi. Esimerkiksi 
pianosäestyksissä soolosoitin kirjoitetaan pienempänä.

Tällä komennolla (Create>Key Signatures tai K) voi vaihtaa 
etumerkintöjä. Duuri- ja mollivaihtoehto kannattaa valita tilanteen 
mukaan, sillä sen perusteella määräytyy tiettyjen kromaattisten 
nuottien kirjoittaminen. Sävellajimerkintää voi siirtää 
nuolinäppäimillä tai hiirellä ja aktivoitu merkintä poistuu Delete-
näppäimellä.

Mikäli sävellajin vaihto sattuu uuden viivaston alkuun, näytetään 
oletusarvoisesti edellisen viivaston lopussa uudet etumerkit. Hide-

valinta kätkee tämän merkinnän. 
Yksittäinen viivasto voi saada 
muista poikkeavan (bitonaalisen) 
sävellajimerkinnän valinnalla One 
staff only.

Line-komennolla (L) aukeavasta ikkunasta valitaan erilaisia kaaria, 
trillejä ja glissandoja sekä kertauksien maalit. Huomaa, että osa 
merkeistä saadaan myös näppäinkomennoilla. Vasemmanpuoleisesta 
kentästä valitaan sellaisia merkkejä, jotka kohdistuvat yhteen 
stemmaan, siis esimerkiksi legato-kaari. Oikean puoleisen kentän 
merkit, vaikka näyttäytyvätkin partituurissa vain yhdessä kohtaa, 
toistuvat sitten stemmojen dokumenteissa. Esimerkiksi ensimmäinen 
maali piirretään partituuriin vain kerran, mutta silti se on mukana 
kaikissa erillisissä stemmoissa sittemmin. Nämä System lines -merkit 
saattavat näkyä partituurissa useassakin kohdassa. Sitä voidaan 
säätää House Style>System Object Positions -komennolla. Siellä voidaan 
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9. Key Signatures

10. Line



määrätä, että merkit näkyvät partituurissa vain ylimmäisellä 
viivastolla.

Legato-kaaren teko. Aktivoi nuotti ja valitse Line-ikkunasta 
legatokaari tai käytä S-kirjainta. Ohjelma tekee kaaren kyseisestä 
nuotista seuraavaan. Pidennä sitä Välilyönti-näppäimellä, Shift-
välilyönti saa kaaren vetäytymään takaisin päin. Hienosäätöä voi 
tehdä nuolinäppäimillä ja cmd-nuolinäppäimen kanssa vähän 
suuremmissa erissä. Mikäli haluat kaaren perussäännön vastaisesti 
toiselle puolelle viivastoa – esimerkiksi kuororeduktiossa, käytä 
Shift–S -komentoa. Voit laittaa kaaren ilman nuotin aktivointiakin, 
mutta silloin se ei ole magneettinen eikä väistele älykkäästi muita 
merkintöjä, joten yleensä kaari laitetaan ensimmäisellä tavalla. 

Kaaren muokkaus. Jos haluat myöhemmin muokata kaarta, toimi 
näin:

• oikeaan päähän osoittamalla voit muuttaa sen pään sijaintia 
nuolilla tai välilyönnillä,

• vasempaan päähän osoittamalla voit siirtää kaaren alkua,

• hiirellä voit muovata kaaren keskikohtaa ja korkeutta yhteensä 
neljästä eri pisteestä,

• Layout>Reset Position tai cmd–Shift–P siirtää kaaren oletuspaikkaan. 

Legatokaari, joka jatkuu viivastolta toiselle, ei piirretä kahtena 
merkkinä, vaan vedetään hiirellä suoraan päätöspisteeseen 
seuraavalla rivillä. Toinen vaihtoehto on käyttää välilyöntiä. 
(Huomaa yhdyskaaren ja legatokaaren ero. Yhdyskaari, joka tulee 
kahden samankorkuisen sävelen väliin, tehdään ohjelman Keypad-
ikkunassa.) 

Maalien teko. Maalin voi tehdä kahdella tavalla: Aktivoi maalin 
sisältämät tahdit ja valitse Line. Osoittamalla sopivaa maalia ja OK-
painiketta koko aktivoidun alueen mittainen maali ilmestyy 
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nuottisivulle. Tässä menetelmässä on sellainen huono puoli, että 
Sibelius venyttää maalin liian pitkäsi. 
Maalina alkua ja loppua voi siirtää 
nuolityökalulla. Toinen tapa on valita 
ensin Line-komennon avulla haluttu 
maali, tipauttaa se hiirellä maalin 
ensimmäiseen tahtiin ja venyttää se 
sitten sopivan mittaiseksi.

Tällä komennolla (myös cmd–R) teet harjoitusmerkkejä. Sibelius osaa 
pitää huolen oikeasta merkistä – myös jos jotain jaksoja poistetaan 
välistä.

Toinen mahdollisuus on jatkaa 
vaikkapa uudessa osassa merkintää 
muusta kuin A-kirjaimesta. Silloin 
käytetään Start at -vaihtoehtoa.

Sibelius tarjoaa myös 
mahdollisuuden liittää 
harjoitusmerkkiin jonkin etu- tai 
jälkiliitteen. Esimerkissä on 
harjoituskirjaimen perään liitetty 
numero 1.
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11. Rehearsal mark



Kun tarvitaan erityismerkkejä, on Symbol-komennon (Z) alla niitä 
useita. Poimi tarvittava merkki ja tipauta se paikkaansa. Ne osaavat 
seurata nuottisivun muutoksia. Mutta jos haet sieltä käyttöösi 
esimerkiksi kromaattisen merkin, se ei muutu transponoinnin 
yhteydessä.

Merkin koko valitaan neljästä 
vaihtoehdosta: Normal (100%), 
Cue (75%), Grace note (60%), 
Cue grace (50%). 

On tärkeää tiedostaa viivaston 
ja systeemin ero: Jos merkki on 
tarkoitettu vain yhdelle instrumentille, kuten vaikkapa trilli, valitaan 
Attach to Staff. Mutta esimerkiksi Coda-merkki, joka vaikuttaa koko 
partituuriin, on tehtävä Attach to System.1

Keskeiset tekstit saa tietenkin näppäinoikoteinä: cmd–E 
esitysmerkkejä varten, cmd–T soittotekniikkaa varten ja cmd–L 
sanoitusta varten. Create>Text -komennolla poimitaan samat 
toiminnot valikosta. Esitysmerkit ja tekniikat tipautetaan nuolella 
paikalleen, Sibelius sijoittaa tekstikentän automaattisesti 
oletusarvoiselle viivaston puolelle, esimerkiksi tempomerkinnät 
tulevat viivaton ylle ja dynamiikkamerkit alle. Sen jälkeen painetaan 
hiirellä ctrl-näppäin pohjassa, jolloin avautuu valikko eri 
vaihtoehdoista. (Valikon nimi on Word Menu. Windowsissa se 
avautuu hiiren kakkospainikkeella.) Kyseisen valikon sisältö vaihtuu 
sen mukaan, mitä tekstikenttää ollaan lisäämässä. Tekstiä voi lisätä 
myös kirjoittamalla.

Mikäli teksti törmää nuottien tai muiden merkkien kanssa, 
Sibeliuksen  Magnetic Layout asemoi ulkoasun automaattisesti 
uudelleen.

Esitysmerkkien lisäämisessä on vielä yksi oikotie: kun olet osoittanut 
merkin paikkaa, kirjoita esimerkiksi cmd–M ja cmd–F, jolloin mf-
merkki tulee näkyviin. Kussakin valikossa on useita 
näppäinoikoteitä.
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1 Coda-merkkien tekeminen symboleilla ei ole suositeltavaa, sillä niiden paikka saattaa ajelehtia 
muokkauksen yhteydessä. Parempi keino on käyttää Create>Text>Other System Text> Repeat 
(D.C./D.S./To Coda) -komentoa.

12. Symbol

13. Text



Sanoitus. Sanoituksen kirjoittaminen voidaan tehdä kahdella tapaa: 
tavu kerrallaan tai kopioimalla ja sijoittamalla valmis teksti melodian 
alle.

1. Tavu kerrallaan: 

• valitse Create>Text>Lyrics>Lyrics line 1 tai cmd–L 

• osoita ensimmäisen nuotin alapuolelle 

• kirjoita tavu 

• paina välilyöntiä tai tavuviivaa, kursori hyppää seuraavaan 
nuottiin. 

Virheitä voi korjata samalla tapaa peruuttamalla, kuin 
tekstinkäsittelyssä. Jälkeen päin virhe korjataan kaksoisosoittamalla 
virheellistä tavua, jolloin kursori alkaa vilkkua ko. tavun perässä.

2. Kopioimalla valmis teksti: 

• luo sanoitus tavuttaen tekstinkäsittelyohjelmalla2

• kopioi teksti 

• aktivoi Sibelius-dokumentin melodiasta ensimmäisen tavun nuotti 

• valitse Create>Text>Lyrics>Lyrics line 1 tai cmd–L 

• paina cmd–V, jolloin ensimmäinen tavu ilmestyy nuotin alle, 
juoksuta samalla tavoin loput tavut.

Tavujen paikkaa voi nuolella muuttaa. Kokeile seuraavaa: tee sana, 
jossa on kaksi tavua ja tavuviiva välissä, siirrä jälkimmäistä tavua 
reilusti oikealle, siirrä väliin jäänyttä tavuviivaa oikealle ja Sibelius 
luo lisää tavuviivoja täyttämään kahden tahdin välistä aukkoa. 

Magnetic Layout pitää huolta ulkoasusta, mutta jos kuitenkin haluat 
siirtää kokonaisen rivin tavujen korkeutta, aktivoi ensimmäinen tavu 
ja komennolla Edit>Select>Select More (cmd–Shift–A) loput tavut. 
Sen jälkeen voit nuolinäppäimillä säätää tekstin korkeutta. 

Valikosta löytyy komennot myös säkeistöille 2–5. Lisäksi komennolla 
Lyrics above staff on mahdollista tehdä sanoitusta viivaston 
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2 Sibelius osaa tavuttaa mm. englanninkielisen tekstin, joten silloin tekstiä ei tarvitse erikseen 
tavuttaa. Avataan txt-tiedosto Create>Text>Lyrics>From Text File... -komennolla.



molemmille puolille. Tällainen tyypillistä kuoronuoteissa. Lyrics 
(chorus) tarjoilee kursivoitua tekstiä.

Other Staff Text. Apuvalikosta on mahdollista poimia 
erilaisia tekstikenttiä, kuten:

Boxed text. Tekstikenttä, jossa on reunaviivat. 

Chord symbol. Tällä komennolla voi laittaa sointuja samalla 
tavalla kuin esimerkiksi Expression-komennolla: Word 
Menu avautuu ctrl-näppäimen kanssa (Windows-koneilla 
hiiren kakkosnäppäimellä).

Drum set legend. Valikossa on erilaisia rytmimerkintöjä. 

Figured bass, kenraalibassomerkintä. Osoita ensimmäisen 
nuotin alla ja kirjoita numero(t). Kromaattiset merkit ovat 
cmd–7, cmd–8 ja cmd–9, muut merkit voidaan laittaa 
Word Menu-valikkoon. Välilyönnillä mennään seuraavaan 
nuottiin. 

Fingering, sormitus. Kirjoita sorminumero, välilyönnillä siirrytään 
seuraavaan nuottiin.

Footnote, alaviite. Alaviite osoitetaan tietyn viivaston tiettyyn tahtiin, 
mutta se ilmestyy kyseisen sivun alareunaan samalla tavalla kuin 
tekstinkäsittelyohjelmissakin.

Function symbols tarjoaa merkintöjä sointufunktioiden analysointia 
varten.

Guitar fingering. Kursivoitu teksti oikean käden sormia varten 
kitaransoitossa.

Plain text. Tavallinen tekstikenttä merkintöjä varten.

Roman numerals. Klassisen musiikin analysointiin soveltuvia 
astemerkintöjä. 

Small text. Tekstikenttä, joka käyttää pientä kirjasinkokoa.

Tiny text on hyvin pientä tekstiä.

Text-valikon alemmassa osassa on sellaisia vaihtoehtoja, jotka 
kohdistuvat koko partituuriin, ja niiden nimi on system text.
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Title, Subtitle, Composer, Lyricist, Dedication. Kappaleen nimi, 
alaotsikko, säveltäjä, sanoittaja ja omistus ovat systeemitekstejä, jotka 
on valmiiksi tasattu joko sivun reunaan tai keskelle. Niinpä niitä ei 
voi siirtää kuin pystysuunnassa. Vaakasäätöjä varten on käytettävä 
House Style-valikon komentoa Edit Text Styles... Nämä tekstit 
voidaan kirjoittaa minkä viivaston päälle tahansa. Samassa 
dokumentissa voi ollakin peräkkäin useita kappaleita otsikoineen.

Tempo ja Metronomi. Tempo- ja metronomimääreitä (cmd–M) varten 
avautuu oma valikko ctrl-näppäimen avulla. (Windows, hiiren 
kakkosnäppäin.) Tee sekä teksti että metronomiosoitus samaan 
kenttään, jotta myöhemminkin osoitus pysyy kuosissa. Jos nimittäin 
nuottikuvaa muokataan, saattavat erilliset merkinnät ajautua 
toistensa päälle. 

Merkintä saattaa ilmestyä – system-tekstin tapaan – partituurissa 
useampaan paikkaan ja yhtä liikuteltaessa sivusuuntaan toinen 
seuraa perässä. Myös merkinnän muutos peilautuu toisiin. Yksittäistä 
merkintää voi liikutella pystysuunnassa ja sen voi poistaa Delete-
näppäimellä. Peilautuminen useille viivastoille poistetaan House Style 
> System Object Positions... komennolla.

Other System Text. Lisää vaihtoehtoja on 
apuvalikossa. Block lyrics on käytännöllinen, kun 
tehdään säkeistöjen sanoituksia itse kappaleen 
alapuolelle. Boxed text tekee laatikon tekstin 
ympärille.

Mikäli uutta kappaletta luotaessa on tehty sille 
myös etusivu, Composer-komennolla tehdään 
siihen tekstiä. Copyright liitetään kappaleen 
ensimmäiseen tahtiin, vaikkakin se ilmestyy 
ensimmäisen sivun alareunaan. ©-merkki on Word 

Menussa.

Headers and Footers, ylä- ja alateksti. Header tekee oletuksena joka 
sivun yläreunan keskelle saman tekstin, Header (after first page) jättää 
ensimmäisen sivun tyhjäksi. Footer-tekstit tulevat alas sivun ulko- ja 
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sisäreunaan (outside ja inside edge). Ylä- ja alatekstit seuraavat myös 
partituurista irrotettuihin stemmoihin.

Metric modulation. Tämän komennon Word 
menu sisältää käteviä merkintöjä erilaisia 
metrisiä muutoksia varten. Esimerkiksi 
l’istesso tempo ja swing-merkinnät poimitaan 
täältä.

Plain system text tuottaa tavallisen 
tekstikentän. Täältä kannattaa myös valita 
Coda- ja Segno-merkinnät (Repeat). Title (on title Page) sijoittaa 
kappaleen nimen otsikkosivulle.

Blank Page Text. Tähän valikkoon on kerätty tyypillisiä tekstejä, joita 
käytetään tyhjällä sivulla.

Special Text. Valikosta on mahdollista 
tehdä tekstikenttiä, jotka eivät 
noudata ohjelman tavallisia 
asetuksia. Esimerkiksi jos haluat 
tehdä kappaleen alkuun tekstin Intro 
samanlaiseen tyyliin kuin 
harjoituskirjaimet, valitse 
Create>Text>Special text>Rehearsal 
marks. Näin saat tekstin, joka on 
(oletuksena) lihavoitu 20-pisteinen ja 
laatikon sisällä.

Tekstin kätkeminen. Kappaleen soittoa varten voi olla tarpeellista 
tehdä metronomimerkintöjä tai dynamiikkamerkkejä, jotka eivät näy 
partituurissa. Aktivoitu teksti kätketään komennolla Edit>Hide or 
Show>Hide tai cmd–Shift–H.

Tahtilaji muutetaan tällä komennolla (tai kirjain T). Valitse sopiva 
tahtilaji, Other-kenttään voi sommitella harvinaisempia 
tahtiosoituksia. Myös yhdistelmätahtilajit ovat mahdollisia, kirjoita 
esim. 5+3 ylempään kenttään. Sibelius osaa myös jakaa nuotit 
uudestaan tahteihin, jos tahtilajia vaihdetaan.
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14. Time Signature



Allow cautionary sallii tahtilajin vaihtuessa huomautuksen edellisen 
viivaston lopussa. Kohotahti (Pickup) määritellään lisäämällä 
kenttään sopiva määrä nuotteja.

Tahtilajien 8-, 16- ja 32-osat voidaan ryhmittää mieleisellä tavalla. 
Painikkeen Beam and Rest Groups kautta avautuu ikkuna. 
Ylimmäisenä vaihtoehtona määritellään, montako kahdeksasosaa 
niputetaan yhden palkin alle. Seuraavilla valinnoilla voidaan määrätä 
16- ja 32-osien ryhmityksistä.

Dokumenttiin voidaan tehdä otsikkosivu. Avautuvan ikkunan 
kenttiin kirjoitetaan kappaleen nimi ja säveltäjätiedot, minkä jälkeen 
ensimmäisen sivun eteen tulee uusi sivu em. tietojen kanssa.

Triolit ja muut monijaot tehdään kahdella eri tavalla. Tavallisesti on 
yksinkertaisinta käyttää näppäinoikoteitä: 

1. laita triolin ensimmäinen nuotti viivastolle 

2. näppää cmd–3 (tai kolmosen tilalla mikä tahansa 2–9 monijaosta 
riippuen) 

3. kirjoita loput nuotit.

Toinen keino on käyttää valikkokomentoja. Tämä on tarpeen 
esimerkiksi silloin, kun tehdään kvartoli kolmijakoiseen tahtiin. Laita 
ensimmäinen nuotti, sen jälkeen: 

1. Create>Tuplet,

2. kirjoita kenttään monijaon suhdeluku, 

• Number laittaa nuottiryhmän päälle yhden numeron,

• Ratio koko suhdeluvun (esim. 4:3), Ratio + note lisää myös aika-
arvon suhdeluvun perään ja
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15. Title Page

16. Tuplets



• None jättää monijaon ilman merkintöjä. 

• Auto-bracket yhdistää nuotit hakasella, jos nuotit eivät muuten 
ryhmity selkeästi. Tämä on ohjelman oletusarvo, sillä hakasta ei 
tarvita esimerkiksi kolmen kahdeksasosan trioliryhmässä. Bracket 
pakottaa hakaset joka paikkaan ja No bracket estää hakaset. 

• Full duration venyttää hakasta seuraavaan nuottiin asti 

 

3. OK, 

4. osoita monijaon ensimmäistä nuottia ja kirjoita loput nuotit.
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Other-apuvalikon taakse on laitettu harvemmin tarvittavia 
komentoja.

Bar Number Change. Create>Bar Number Change -
komennolla muutetaan automaattista tahtinumerointia 
esimerkiksi uuden jakson alussa.3 New bar number 
vaihtaa tahtinumeroinnin alkamaan siitä numerosta, 
joka kirjoitetaan kenttään.

Follow previous bar number on käytännöllinen silloin, kun 
numerointitapaa muutetaan Change format -
komennolla (ks. alla). No bar number hyppää 

numeroinnissa kyseisen tahdin ylitse. Tämä on tarpeen, mikäli jokin 
tahti on fraasien vuoksi jaettu kahtia, mutta sen ei ole tarkoitus 
vaikuttaa tahtinumeroihin.

Add text lisää tahtinumeron eteen tai perään tekstiä, vaikkapa 
kirjaimen.

Change format muuttaa numerointitapaa siten, että järjestys 
ilmaistaankin aakkosilla. Tällaista käytetään esimerkiksi 
musiikkiteatterissa, sillä näin voidaan lisätä tarvittaessa johonkin 
kohtaukseen tahteja ilman, että varsinainen numerointi muuttuu. 
Seuraavassa esimerkissä on lisätty pari tahtia neljännen tahdin 
jälkeen, minkä jälkeen numerointi jatkuu normaalisti viidennestä 
tahdista.
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3 Varsinaisesti tahtinumerot määritellään House Style>Engraving Rules -komennolla. Valitse 
ikkunasta Barnumbers.Valintana on numero joka tahtiin, viiden tai kymmenen tahdin välein, 
joka viivastoryhmän alkuun tai ei lainkaan. Center in the bar laittaa numeron tahdin yläpuolelle 
keskelle, Show at start of sections laittaa numeron myös ensimmäiseen tahtiin. Numeroinnin 
tyyli vaihdetaan Edit Text Style -komennolla.

17. Other



Bracket. Hakaset tai akkolaadi partituurin viivastojen väliin tehdään 

seuraavasti: 

1. Create>Bracket ja valinnan mukaan Bracket, Sub-bracket tai Brace, 

2. osoita viivaston vasemmalle puolelle, 

3. raahaa hakasta ylös tai alas yhdistämään viivastoja. 

Guitar scale diagrams. Kitaraoppaissa on monesti kuva kitaran 
otelaudasta, johon merkitty jonkin asteikon sävelet mustina täplinä. 
Sibelius tarjoaa 25 asteikosta eri transpositiot mukaanlukien satoja 
valmiita vaihtoehtoja. Lisäksi on niitä tietenkin mahdollista 
räätälöidä tarpeen mukaan itse. Asteikon lisääminen sujuu helposti, 
komennon jälkeen osoitetaan hiirellä haluttuun kohtaan. Sibelius 
avaa ikkunan, jonka valintojen avulla voi hakea tarvitun asteikon. 
Oletuksena asteikko tehdään normaalivireiselle kitaralle, mutta 
muitakin viritysjärjestelmiä ja kielisoittimia on valittavana.

Hit Point. Komentoa käytetään videokuvan tahdistamisessa.

Instrument Change. Jollakulla soittajalla saattaa olla kirjoitettuna 
tehtäviä useammalle soittimelle. Esimerkiksi klarinetistin täytyy 
vaihtaa B-vireisestä soittimesta A-vireiseen, huilistin alttosaksofoniin 
tai lyömäsoittajan guirosta tamburiiniin. Tällä komennolla poimitaan 
soitin Sibeliuksen soitinvalikoimasta ja sijoitetaan merkintä siitä 
nuottiin. Sibelius osaa tarvittaessa muuttaa transponoinnin vuoksi 
sävellajia, klaavia, jne.
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Klaavin muutos sallitaan Add clef -valinnalla. Sibelius laittaa 
tarvittaessa automaattisesti huomautuksen soittimen vaihdosta: 
Announce at last note of previous instrument.

Ossia Staff. Aktivoi tahti tai tahteja, joihin ossia liittyy, ja valitse 
valikosta Ossia Above tai Ossia Below.

Page Number Change. Sivunumeroinnin muutos tapahtuu tämän 
komennon kautta. Sen voi myös aloittaa sopivasta numerosta (New 
page number), ja numeroiden sijasta voi käyttää kirjaimia (Format).

Paitsi että numerointi olisi näkyvissä tavalliseen tapaan (Show page 
numbers), voi ensimmäisen sivunumeron kätkeä (Hide first page 
number) tai numerot voi kätkeä kokonaan. Numerot voidaan myös 
tarvittaessa poistaa niiltä sivuilta, joilta puuttuvat nuottiviivastot.
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